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1. Overview
Netrix iCMS handles articles, which can contain text objects, images, tables, and styles.
These articles are stored in an on-line database, which allows archiving, reusing, editing,
and re-publishing them in various ways.
To create an article in iCMS you can follow two approaches:
-

-

An article can be created in the CMS database, with a web interface or any other
connected authoring application. Then, you can insert it into your InDesign document
with the Asset Manager InDesign plug-in. The article keeps its connection with the
database and all changes will be synchronized.
An article can be created in the InDesign document. To do this, you just have to tag
its elements (title, lead, subtitle, body, author...). If tagged, articles are automatically
discovered and created in the CMS database.

If an article is connected, all the modifications will be synchronized between the CMS and
the InDesign document. Synchronizing is done automatically in the event of saving (Ctrl+S).
Formatting is also preserved and converted between platforms.
Logging in: you can find the iCMS InDesign plug-in under the „Window/Netrix iCMS Asset
Manager“ menu. On the first use, set your username and password in the “Settings” (cog
icon) window.

2. Getting started
2.1 Installing Netrix iCMS plugin
2.1.1 Standalone installer (recommended method)
You can download the platform-specific installer from our websites “Downloads” page
(https://netrixlabs.com/downloads/). Launch the installer and follow the instructions. After the
installation has finished, restart Indesign.

2.1.2 Installing from Adobe Exchange
Go to the plugins Adobe Exchange page
(https://www.adobeexchange.com/creativecloud.details.18897.html). Click on the "Install"
button. The installation will start soon. In order to use this method, you have to run the
Adobe Creative Cloud application in the background. After the installation has finished,
restart Indesign.
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2.2 First start of the Netrix iCMS plugin
Open the “Window” menu and under the “Extensions” submenu click on the “Netrix iCMS”
menu item.

If you have already registered to Netrix iCMS, log in on the following screen. If not, click on
the “Sign up” button and fill in the registration form.

After you have registered or logged in, start the asset manager by clicking on the “Open
asset manager” button.
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2.3 iCMS Asset Manager window
Articles in the CMS database can be accessed with “Netrix iCMS Asset Manager” plugin.
You can find it in the „Window/Netrix iCMS Asset Manager“ menu.
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2.3.1 Elements of the asset manager window
Articles in the CMS tab
● Search options: search criteria
● Article list: list of articles which are matching to the search criteria
● Article details: here you can see the details of the selected article
Articles in the document tab
● Document info: basic information of the document
● Article list: list of articles which are contained by the document
● Article details: here you can see the details of the selected article

2.4 Search and list from the CMS
Articles in the CMS database can be searched and filtered with the fields on the upper part
of the window. The list displays all the articles that match your search criteria.

Columns in the list:
● ID: unique identifier number of the article
● (status): i ndicators for the status of the article
○ Square filled: t he article is inserted in the actual document
○ Empty square: the article is inserted but in another document
○ !! (two exclamation marks): article has been modified since the last insertion
○ No indicator: a
 rticle is not yet inserted to any document
● Title: the title of the article
● Page no.: t he planned page number for publishing. “1 + n” means an article starting
on the cover page and flowing to page N.
● Used: indicates if an article has been inserted into a document, and when.
Selected article
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The selected article part of the window has two fields:
● The left one shows data for the selected article in the list above.
● The right field show data for the article selected in the InDesign document. It can be:
○ “Empty article”, which indicates a ready structure with no article yet;
○ Article data for an already placed article, or a part number for multipart
articles.

2.5 Inserting an article from the CMS to the InDesign document
1. To Paste Board: this function places the article selected in the list to the actual page
of the document, to the left pasteboard. You can then format and edit its text fields.
The database connection for the article is set.
2. Place: this function places the article to the actually selected textboxes in the
document, keeping the formatting of the boxes, as a template. You have to select at
least one text box to place. The text boxes and all the elements of the article
template must be structured and tagged correctly in the InDesign „Structure
(Alt-Ctrl-1)“ window. (See details in section 3.)
Other operations
3. Unlink: disconnects the selected article from the CMS database. The changes in the
article will not be synced from this point.
4. Details: A
 rticle data fields and metadata can be inspected/edited in this window.
5. CMS: O
 pens the article in the CMS web interface.
6. Refresh: refreshes the article list. (Refresh is also automatic by 5 minutes.)
7. Settings: Set login credentials and other parameters for the plugin.

2.6 Creating an article in InDesign, with CMS connection
If you tag elements of a new article on a page (title, lead, subtitle, body, author...) and those
elements are structured in the document as an article (“Structure” window, Alt-Ctrl-1), then
all the content in these fields will form an article and will be saved to the CMS. (See details in
section 3.)

2.7 Saving article content
CMS saving is automatic. Tagged articles keep their connection with the CMS. If a
modification occurs in the article content, it is automatically saved in the database too. CMS
saving is done in the event of the InDesign document save (Ctrl+S).
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3. Structure of the InDesign document
To handle articles, it is needed to have separate text boxes for
the article elements (title, lead, subtitle, body, author...). It is also
needed to have these elements tagged, in the same structure.
To see the structure of the document you can use the
“Structure” panel (“Alt-Ctrl-1”). It is recommended to keep this
panel open.
To create a structure, first create the text boxes of the article
and tag them by dragging them to the structure panel one by
one. Then, select all of them, and in the right-click context menu
select “Make article from selection“. This will arrange elements
in the correct structure. That’s it!
If you don’t see the iCMS specific tags (article, title, lead, etc.),
you can create them by clicking on the “Create iCMS tags” menu item on the tags panel’s
submenu. You can also enable the plugin to create automatically these tags for every
document you have opened. For this setting, see the 5.1 section.

If you want to insert articles from the CMS to a template with the “Place” button, you need to
create the above structure in advance. The “Place” function finds the structure and tags and
knows where to put the appropriate content. You can also create a template system with
master pages and library items, so the tagging is done only once.
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If you insert an article with the „To Paste Board“ button, then there is no need to create any
template or setting. It will create the correct tagged structure automatically.

4. Other functions
4.1 Adding new fields to an inserted article
If you want to add new elements (for example text frame, image) to an already placed article,
it is important to do this in a structured way. You have to drag the newly created element to
the structure panel, to the appropriate article, and select a tag (for example Frame, Image).
The new tagged object will become part of the article and be saved to the CMS from now on.
Note: if you add new objects to the article and do not tag them, these will not be saved in the
CMS, only in the InDesign document.

4.2 Handling text frames
Text frames can be created and stored separately, in the CMS web admin “Add new field”
function. These fields will become separate text boxes in the InDesign document. If there are
„frame“ tagged textboxes in the documents, contents will appear in them. If there are no
such tagged boxes, new text objects will be created in the center of the page and those can
be moved and formatted.

4.3 Handling images
Images can be attached to the article in the web admin, “Media Library” panel and the
“Featured images” tab. These images will appear in the image boxes tagged as „image“. If
there are no such tagged boxes, new image objects will be created in the center of the page
and those can be moved and formatted.
Note: to handle images, it is required to have a file-level connection between the CMS server
and the InDesign workstation. This can be achieved by a local file server or Dropbox. See
details in the “Settings” section.

4.4. Details, page number and issue
In the AssetManager plug-in, by selecting an article in the list and clicking “Details”, you can
inspect all the content and metadata of it. The metadata fields are editable. After designing
the final issue pages, it is recommended to set the fields “issue” and “page number” to the
correct value, for archiving, and accounting purposes.
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4.5. Revoke article
Articles that are displayed in the AssetManager plug-in have a status of “Live”, “Published
article”. These articles can not be modified in the CMS web admin, only in the InDesign
document. To revoke and give an article back for editing it is recommended to revoke it on
the web admin, with the “Revoke” button.
The revoked, modified and re-submitted article is indicated with a “!!” icon.
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4.6 Keyboard shortcuts

The function “Make article from selection” can be assigned to a keyboard shortcut. In the
“Scripts” section you have to tie the shortcut to the command “User: NXAssetManager:
makeSelectionArticle.jsx”.
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4.7 Copy with structure
In the “Edit” menu, you can find options for copying and pasting articles together with their
tags, structure and CMS connection.

These can be tied to keyboard shortcuts. Assign “User: NXAssetManager:
copyWithStructure.jsx” and “User: NXAssetManager: pasteWithStructure.jsx” scripts to
shortcuts.

4.8 Quick select article in the document
In the Asset Manager Window, double-click an article in the list to see its inserted place in
the active document.
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5. Settings
5.1 Settings panel

Domain, e-mail address, password, access token, htaccess username/password
These fields are the login credentials to the Netrix iCMS. If you have registered or logged in
in the way as shown in the 2.2 section, these fields are filled in on the proper way. You have
not any task with them. In case of on-premise installation, your local system administrator
will provide the values of these fields.
Sync images, type of image sync folder
If you want to synchronize your images between the CMS and the Indesign document, you
have to turn on the “sync images” option. As “type of image sync folder” select the Dropbox
option. The “custom” option requires on-premise iCMS installation, and in this case, you will
get the required image folder setting from your system administrator. For further information
see the 5.2 section.
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Refresh rate of search results
The time interval between two refreshes of the search results.
Notification refresh rate
If you enable this setting, you will receive notifications if a new article is created in the CMS
which matches to the previously set search criteria. You will get these notifications even if
the Asset manager window is closed.
Sync article page no. to CMS
If enabled, the plugin sends back to the CMS that on which document page did you place
the article.
Create missing tags automatically
If you enable this setting, the plugin automatically adds the iCMS tags to the opened
document. Not recommended if you are working documents which are not handled by the
iCMS.
Create missing styles automatically
If this setting is enabled, the plugin automatically adds the missing styles to the document
when you place an article.
Export issue preview to the CMS
If this setting is enabled, the plugin creates and uploads a PDF preview of the articles to the
CMS upon document save. Not recommended for large documents with several articles.

5.2 Style handling, formatting
Style conversion: by default the paragraph and character style definitions in InDesign will
become ‹p› and ‹span› markups on the web database, with the same class name as the
style. For more specific conversion, you can set assignments in the CMS on the “Article
editor settings” page. You can find this under the “gear” icon on the top right side of the
page.
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Under the “Text styles” and the “Table styles” tab you can add your own paragraph,
character and table styles and set their online appearance. In order to make the style
synchronization between the CMS and the Indesign document flawless, you have to create
all the styles you are using in your documents.
Under the “Extra database fields” tab you can add extra, WYSIWYG editable fields to the
article editor. These fields also can be placed to the Indesign documents with their own tags.

5.3 Synchronizing images
InDesign needs a file-level connection with the CMS server to handle images. This can be
achieved with a local fileserver, or more easily, Dropbox.
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5.3.1 Using Dropbox image sync
If you have a Dropbox account and the Dropbox client installed, that's enough. You need to
enable Dropbox access from the CMS server too, you can do it in the CMS admin. Log in
with your user to the web admin, and under your user’s "My account" menu Dropbox tab,
connect to your Dropbox account. From that point, all images attached in the CMS articles
will be synced to your workstation and will be inserted to the InDesign document
automatically.

5.3.2 Using local fileserver image sync
If you plan to use images in your document more heavily, we recommend to run a local
fileserver, accessible from your workstation in a folder, and also accessible from the CMS
server with an SSH account (rsync). To start the image sync, on the iCMS admin, “Fileserver
sync” module you need to set the host and account to the file server. Also in the
NXAssetManager InDesign plugin, Settings panel, you need to set the file sync method to
custom and enter the folder where the images will be located in your workstation’s
filesystem. From that point, all images attached in the CMS articles will be synced to your file
server and will be inserted to the InDesign document automatically.
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